Notice

© SDL Group 2010-2018. All rights reserved.
Printed in U.S.A.

SDL Group has prepared this document for use by its personnel, licensees, and customers. The information contained herein is the property of SDL Group and shall not, in whole or in part, be reproduced, translated, or converted to any electronic or machine-readable form without prior written approval from SDL Group. Printed copies are also covered by this notice and subject to any applicable confidentiality agreements.

The information contained in this document does not constitute a warranty of performance. Further, SDL Group reserves the right to revise this document and to make changes from time to time in the content thereof. SDL Group assumes no liability for losses incurred as a result of out-of-date or incorrect information contained in this document.

Trademark Notice

See the Trademark Notice PDF file on http://docs.sdl.com for trademark information.

U.S. Government Restricted Rights Legend

Use, duplication or disclosure by the government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or other similar regulations of other governmental agencies, which designate software and documentation as proprietary. Contractor or manufacturer is SDL Group, 201 Edgewater Drive, Wakefield, MA 01880-6216.
Contents

Chapter 1
Preparation to Install XPP

- Pre-Installation Information for XPP ........................................ 1-1
- Directory Structure ............................................................... 1-1
- Temporary Files Directory ..................................................... 1-1
- Distribution Directory .......................................................... 1-2
- Quick Access to XPP Directories ............................................. 1-2

Chapter 2
Licensing

- About Licensing ................................................................. 2-1
- Sharing a License Server with Contenta .................................... 2-2
- Multiprocessor Reporting Tool ................................................ 2-2
- Obtaining a License ............................................................. 2-4

Chapter 3
Third-Party Software and XPP

- Third-Party Software Modules Required When Upgrading XPP ...... 3-1
- Java ..................................................................................... 3-1
- Installing in a Networked Environment ..................................... 3-1
- Using an NTFS File System or Active Directory ....................... 3-2

Chapter 4
Installing XPP

- Overview ............................................................................... 4-1
- Java ..................................................................................... 4-1
- Installing XPP Server ............................................................. 4-2
- Post-Installation Tasks ........................................................... 4-4
- Installing the XPP Client ......................................................... 4-5
Chapter 5
Upgrading XPP

Overview ................................................................. 5-1
Java ............................................................................ 5-1
Upgrading from XPP 7.3 or earlier ................................. 5-2
Upgrading the XCS Spec ............................................. 5-2
Upgrading XPP Servers .............................................. 5-3
Post-Upgrade Tasks .................................................. 5-5
Upgrading XPP Clients .............................................. 5-6
Post-Upgrade Tasks .................................................. 5-7

Chapter 6
Post-Installation Configuration

Locating the Latest Configuration Files and Specs .......... 6-1
Distribution and Destination Directories ....................... 6-1
UNC Format .................................................................. 6-5
Document Paths ........................................................ 6-5
Environment Variables ............................................. 6-6
Graphics Paths .......................................................... 6-6
Configuring the Command Window .............................. 6-7
Configuring System Processes .................................... 6-7
Configuring Print Direct to PDF (Upgrade Only) .......... 6-7
Completing an Upgrade of XPP Server ......................... 6-8
Converting Data ....................................................... 6-8
Converting Xresources to GTK Resources ..................... 6-9
Conversion Utility Syntax .......................................... 6-9
Installing the Shakespeare CSS Demo ......................... 6-10

Chapter 7
Performing a Silent Installation or Upgrade

Silent Installation/Upgrade ........................................... 7-1
Running the Installer in Record Mode ......................... 7-1
Optional Arguments for the setup.exe Command .......... 7-1
Sample Installation Configuration File ......................... 7-3
Running the Installer in Silent Mode ............................ 7-5
Sample Installation Log File ...................................... 7-5
Appendix A
Establishing Secure Access (Optional)

Assumptions and Recommendations ........................................... A-1
  System Default Configuration .............................................. A-1
XPP and Security ........................................................................... A-2
  Pre-Installation Configuration .......................................... A-2
  Post-Installation Configuration ........................................ A-2
  Special Windows Groups and XPP Permissions ......................... A-3
  Application Permissions Groups and Multiple Domains ............. A-4
  XPP Security Lock-Down Mode ........................................... A-4
  Source of Access ..................................................................... A-6
  Share Permissions .................................................................... A-6

Appendix B
Troubleshooting

Troubleshooting ............................................................................. B-1
  Third-party Upgrades ................................................................ B-3
    First Attempt ........................................................................ B-3
    Second Attempt .................................................................... B-3

Appendix C
Licensing Across a Firewall

Changing the Port Number ............................................................. C-1
Pre-Installation Information for XPP

This section describes the recommended directory paths for the XPP software, but you can install to any directory on any partition that is large enough to accommodate the software.

Directory Structure

The following table shows the default structure of the main XPP software directories, where path represents the location you selected to install XPP. For example, the default path (the path where XPP is installed) is c:\XPP

Note: You can define additional data handles in any location on your system.

Table 1-1: Directory Structure

<table>
<thead>
<tr>
<th>Directory Description</th>
<th>Software Directory</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>XPP executable programs</td>
<td>xz</td>
<td>path\xz</td>
</tr>
<tr>
<td>Style libraries</td>
<td>sd_liz</td>
<td>path\sd_liz</td>
</tr>
<tr>
<td>Temporary files</td>
<td>temp</td>
<td>%WINDIR%\temp</td>
</tr>
<tr>
<td>CLS, GRP, JOB hierarchy</td>
<td>std_jobz</td>
<td>path\std_jobz\alljobz</td>
</tr>
<tr>
<td>Perl</td>
<td>Perl</td>
<td>C:\Perl</td>
</tr>
</tbody>
</table>

Temporary Files Directory

The XPP installation sets the directory path (path prefix) it uses to store temporary files to %WINDIR%\TEMP. The installation program sets the %XYV_TMFS% environment variable to point to it.
When XPP successfully processes a file, it removes the associated temporary files from the directory. However, if processing fails, the associated temporary files remain in the directory.

*Note:* XPP stores temporary graphics files in the `%XYV_TMPS%` directory. These graphic files can be very large (over 100 MB for color-separation images), so you must specify an area on your disk with sufficient space to hold potentially large temporary files.

### Distribution Directory

XPP delivers some files to the distribution directories (`<path>\sd_liz\xylibrary` and `<path>\xz\distr`) so that existing customizable specs and libraries are not overwritten.

### Quick Access to XPP Directories

During the installation process, the following XPP environment variables are set.

<table>
<thead>
<tr>
<th>Environment Variable</th>
<th>Description</th>
<th>Prompted For or Set During Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>%XYV_EXECS%</code></td>
<td>The <code>xz</code> directory</td>
<td>Path for software</td>
</tr>
<tr>
<td><code>%XYV_STYLES%</code></td>
<td>The <code>sd_liz</code> directory</td>
<td>Path for style files</td>
</tr>
<tr>
<td><code>%XYV_TMPS%</code></td>
<td>The <code>temp</code> directory</td>
<td>Path for temp files</td>
</tr>
<tr>
<td><code>%PSRESOURCEPATH%</code></td>
<td>The <code>xz/psres</code> directory</td>
<td>Path for fonts</td>
</tr>
<tr>
<td><code>%XYV_ADVP_NODE%</code></td>
<td>The host name</td>
<td>The ADVP server name</td>
</tr>
<tr>
<td><code>%GTK_DATA_PREFIX%</code></td>
<td>The <code>xz/gtk</code> directory</td>
<td>User interface Toolkit</td>
</tr>
<tr>
<td><code>%GTK_EXE_PREFIX%</code></td>
<td>The <code>xz/gtk</code> directory</td>
<td>User interface Toolkit</td>
</tr>
</tbody>
</table>

After setting the environment during the installation process, you can use these environment variables to navigate to directories when working at a command prompt. For example, `cd `%XYV_EXECS%`%` will change your current directory to the `"path\xz"` directory. Similarly, `cd `%XYV_STYLES%`%` will change your current directory to the path where `sd_liz` was installed.
About Licensing

You must install a new license file on your server or stand-alone system if you are doing one of the following:

- Installing or upgrading XPP
- Installing a new XPP software option (CITI, for example)

You can complete the installation without the license file, but it is recommended that you obtain and save the license file on the designated server or servers before installing XPP. You cannot open or compose a division until you install the license file.

Only one active license file is permitted in the License Manager folder. The License Manager will recognize any license file, whether it is active or not. Therefore, if you are replacing an existing license file with a new one, you should back up the old .lic file and rename it (possibly with a .bak file extension). Then install the new license file as is and run rlmreread.exe against it.

*Note:* XPP 9.2 can be installed with Contenta 5.5 or Contenta 5.6.

Releases prior to XPP 8.3 used FlexLM as the license manager. Releases of XPP 8.3 and later use the Reprise license manager.

If you are installing or upgrading to XPP 9.2, you must install the license manager to upgrade to Reprise Version 12.2.

If FlexLM is required by applications other than XPP, it can coexist on the same computer as the new Reprise licensing program. However, if FlexLM is not required, it should be removed from the server. Installing the Reprise License Manager for XPP does not automatically remove the old FlexLM Manager.

*Note:* When installing the Reprise License Manager, you may encounter the error message “Installer User Interface Mode Not Supported” and the Reprise installation will fail. This may be due to your admin login user name containing special characters (for example, “!”).
About Licensing

*Note:* When attempting to run XPP, you may encounter the error message “Bad server hostname in license file or port@host” and the XPP application will fail. This may be due to either an incorrect hostname in the license file, or if an sdlxysoft_LICENSE environment variable exists, an incorrectly entered hostname in this environment variable.

If you change the port number in the license file on the XPP server from its default of 5053, then you must manually make this same change in the sdlxysoft_LICENSE environment variable on each XPP client (see Changing the Port Number on page C-1).

Sharing a License Server with Contenta

If you are using a common license file shared between Contenta and XPP and the license on the Contenta server contains the XPP features as well as those for Contenta, you should **not** install the Reprise License Manager on the XPP system.

To point to the Contenta server for license management, perform the following steps:

1. As an administrator on the XPP system, access the **Control Panel > System > Advanced System Settings** dialog and activate the **Environment Variables...** button.
2. Go to the System Variables section and select the **New...** button.
3. Create a new variable named `sdlxysoft_LICENSE` and set its value to `5053@servername`. (where `servername` is the name of the Contenta server managing the license file). You do not need to copy the license file to the XPP system.

  *Note:* If the Contenta server has been configured to use a different port, change the 5053 to the reconfigured port number for the license manager.

Multiprocessor Reporting Tool

XPP includes a multiprocessor reporting tool that records the number of CPUs available on the licensed server. This tool is an independent diagnostic tool that monitors the calls to the operating system on the machine on which you are running the tool.

The reporting tool helps you monitor compliance of your use of CPUs with the system agreement you have with SDL. The reporting tool does not send a report to SDL. However, SDL may periodically request a report from you. The reporting tool runs automatically and you can also run it manually.

The reporting tool runs automatically as part of the installation process for XPP. The installation program generates a message indicating that the tool has run and displays the report in the install wizard. You can also run the tool manually at any time by using the following procedure.

Do one of the following:

- In XPP **PathFinder**, click **Tools > More Tools > cpureport.pl**
At a command prompt, type "%XYV_EXECS%\procs\site\cpureport.pl"

The report is a printable ASCII log file, written to "%XYV_EXECS%\sys\config\cpu.log."
Obtaining a License

To obtain a license file, log a support case by performing the following steps:


2. Click the Login/Register link in the upper right corner.

3. Log in using your SDL user name and password.

4. Click Log a Case.

You will need an account to log a support case. If you do not have an account, contact the designated representative at your site, as identified in your service agreement.

You will be asked to provide information about your site and XPP server:

- Site code
  Your site code is listed in the implementation package under contact information for your company. The site code also appears as your Customer Number on SDL or XyEnterprise invoices and in existing license files.

- Host name of the designated server
  To determine the host name of the designated server:
  a. Right-click the My Computer icon on your desktop, then click Properties.
  b. Click the Computer Name tab.
     The host name is displayed as the ‘Full computer name.’

- Host ID (MAC Address) of the designated server
  To determine the Host ID of the designated server:
  a. Open a command prompt.
  b. Type ipconfig /all.
     The host ID is the value listed for Physical Address under Ethernet adapter Local Area Connection in the following format: 00-00-00-00-00-00.
     If you have multiple Ethernet connections, use the physical address for the first Ethernet connection in the list.
  c. Alternately, you can install XPP first, then obtain the host ID from the Reprise License Manager folder by issuing the following command at a command prompt:
     
     LicenseManagerInstallDir\rlmhostid.exe -q
     where LicenseManagerInstallDir is the folder where you installed the Reprise License Manager. For example:

     “C:\Program Files\XyEnterprise\SDL_License\rlmhostid.exe” -q
Once your request has been received, SDL should email the license file to you within 24 hours.

1. When you receive the license file, do one of the following:
   - If you have not yet installed XPP, save the file attachment as-is (do not rename it) to any folder on the server.
   - If you have already installed XPP, save the file attachment as-is (do not rename it) to the license manager folder, for example, C:\Program Files\XyEnterprise\SDL_License

   The license file name is customer_number.lic. The license manager requires license files to use the .lic file extension. Only one active license file is permitted in this folder. If you are replacing an existing license file with a new one, back up the old .lic file and rename it (possibly with a .bak file extension). Then copy the new license file into this folder.

2. At that point, you can do one of the following:
   - If you have not yet installed XPP, proceed with installation. When prompted for a license file during installation, navigate to the folder where you saved the file attachment and select it.
   - If you have already installed XPP, navigate to the license manager folder, and then double-click rlmreread.exe.
Third-Party Software Modules Required When Upgrading XPP

This section describes what third-party software versions must be installed when you are upgrading from older versions of XPP.

In this version of XPP, these third-party and SDL software versions will be installed.

- ActivePerl 5.16
- XPP-required Extra Perl Modules
- Optional Extra Perl Modules HTML Documentation
- Reprise License Manager 12.2

The installation steps for specifying these third-party software installation options are described in Installing XPP on page 4-1 and Upgrading XPP on page 5-1.

*Note:* The XPP CD contains subfolders for third-party products that support XPP, some of which also contain installers. You should not run installers from these subfolders. Instead, run the setup.exe from the root (top) level of the XPP CD, which contains a wizard for installing third-party products.

Java

If you use Scalable Vector Graphics (SVG) images, publish using the Perl ePub module, or use XSLT 2 to manipulate data before publishing, you must install Oracle Java 1.6 or later, which you can download from java.oracle.com.

Installing in a Networked Environment

Installing XPP in a networked environment may require that you configure secure access for the application.
Using an NTFS File System or Active Directory

For details, see Establishing Secure Access (Optional) on page A-1 before you begin the installation to complete the preliminary configuration steps.

Using an NTFS File System or Active Directory

If you are using either an NTFS file system or Microsoft Windows Active Directory, you must configure all file systems on drives hosting XPP software and data before installing XPP.
Overview

Before you proceed with these instructions, review these documents:

- SDL XPP Platform Requirements
- SDL XPP Release Notes — This document contains late-breaking product information that might impact the XPP installation instructions in this manual.

These instructions assume that you are familiar with the interactions between XPP and other third-party products, as described in Third-Party Software and XPP on page 3-1.

These instructions apply to installing XPP only on server and client computers that do not have an existing XPP installation in place. If XPP is already installed on your server or client computer, see Upgrading XPP on page 5-1 instead.

Java

If you use Scalable Vector Graphics (SVG) images or publish using the Perl ePub module, you must install Oracle Java 1.6 or later, which you can download from java.oracle.com.
Installing XPP Server

To install XPP server:

1. Obtain a license file and place it in the folder as specified in Obtaining a License on page 2-4.

2. Grant “Full Control” permissions to the Windows TEMP directory, C:/Windows/Temp to the Administrator and Domain Users groups.

3. Log in as a local administrator.
   
   **Note:** Either UAC (User Account Control) must be completely turned off, or if UAC is enabled, then if the system does not prompt to run setup.exe with Administrator permissions, you must cancel out of the install and then right-click on setup.exe and select Run as administrator.

   **Note:** On Windows Server 2012 (and later versions of Windows), turning UAC completely off is a two-step process. Setting UAC to Never notify via Change User Account Control settings in Action Center is only the first step needed to completely turn off UAC. After you do that step, User Account Control will still show as On in the Action Center panel. Check the web for instructions on how to complete the second step to modify the appropriate Local Security Policy via Server Manager to completely turn off UAC, so that User Account Control shows as Off in the Action Center panel. If you only complete step one, then Windows will not prompt to run setup.exe with Administrator permissions and will not run setup.exe with Administrator permissions and that will cause problems with the installation.

4. Download and mount the installation ISO file. To mount an ISO file, right-click on the file and select Mount. Windows mounts the ISO file to the next available drive letter. Alternatively, you can use a third-party tool to mount the ISO as a disk.

5. On the installation media, double-click setup.exe.

6. In the Welcome panel, click Next.

7. In the License Agreement panel, read the software License Agreement, then click Yes.

8. In the Setup Type panel, click:

   - XPP Server to install the full XPP server application including user interface programs.

   - XPP Embedded Server to install the XPP server without user interface programs. With this option, XPP can be run only from the command line.

   After you have selected the type of installation, click Next.

9. In the Select Features panel, make any desired changes in the features to be installed and click Next.

   **Note:** If auto-processing is not required, this feature can be turned off.

   **Note:** During installation, XPP examines the version of the Reprise License Manager; if it detects Version 12.2, it will not be reinstalled.
10. In the Choose Language panel, click the language in which you want XPP messages to display, then click **Next**.

11. In the Choose Install Folder panel, specify where to create the **xz** folder, and then click **Next**.

   **Note:** *This install path is the [XPP_home] variable*

   The **xz** folder contains subdirectories of XPP executable programs and configuration files. It is strongly recommended that you install **xz** and **sd_liz** to the same folder.

   These folder names are case-sensitive. Use only lowercase letters for **xz**, **sd_liz**, and **std_jobz**. If you type a path name, you must include the disk volume. If the folder you specify does not exist, the installation program creates it.

12. In the Choose Style Files Folder panel, specify where to create the **sd_liz** folder, then click **Next**.

   The **sd_liz** folder contains the style files and libraries. It is strongly recommended that you install **xz** and **sd_liz** to the same folder.

   These folder names are case-sensitive. Use only lowercase letters for **xz**, **sd_liz**, and **std_jobz**.

13. In the Choose Destination Location panel, specify where to create the **Perl** folder. It is recommended that you accept the default location.

   **Note:** The installer will detect if Perl is already installed and display a dialog prompting you to indicate whether to continue installing Perl. Click **No** to cancel the Perl installation and continue the XPP installation. It is recommended that you do not install Perl over a previously installed instance.

   **Note:** When selecting a path, the installer will always append “/Perl” to the path if it does not already end in “/Perl”.

14. In the Start Copying Files panel, review your settings, then click **Next** to begin installing. The installer displays a progress bar showing the progress of the installation of XPP programs, and a dialog showing the status of the installation of any third-party software selected.

15. The XPP install will continue with a **cmd.exe** window automatically opening to display the installation progress of the XPP-required Perl modules. After the modules are installed, press any key in the DOS window to complete this step and continue.

16. In the Do you have a license file to install? dialog, click **Yes**.

17. Enter the license file path name (see **Obtaining a License on page 2-4**), and then click **Next**.

18. In the Multiprocessor Check window, click **Next**.

19. If prompted to restart, click **Yes, I want to restart my computer now**.

20. Click **Finish**.
Post-Installation Tasks

1. This step applies only if you are installing Windows XPP clients serviced by this Windows XPP server. In step 11 on page 4-3, XPP was installed to a path, which you referred to as \{XPP_home\}. In this step, you are going to share the last directory component of \{XPP_home\} and the name assigned to that share you will call \{XPP_share\}.
   
a. Define \{XPP_home\}
   
   \{XPP_home\} = "c:\XPP"

   Note: If the \(xz\) and \(sd_liz\) folders are installed in different locations, share each of those folders.
   
b. Define \{XPP_share\}

   Share the "XML Professional Publisher" directory, giving it a unique share name, such as "xpp." Now \{XPP_share\} refers to that share name. All XPP users must have both read and write access to the \{XPP_share\} folder.
   
c. Set the following environment variables:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>%XYV_EXECS%</td>
<td>(server{XPP_share}\xz</td>
</tr>
<tr>
<td>%XYV_STYLES%</td>
<td>(server{XPP_share}\sd_liz</td>
</tr>
<tr>
<td>%PSRESOURCEPATH%</td>
<td>(server{XPP_share}\xz\psres</td>
</tr>
<tr>
<td>%GTK_DATA_PREFIX%</td>
<td>(server{XPP_share}\xz\gtk</td>
</tr>
<tr>
<td>%GTK_EXE_PREFIX%</td>
<td>(server{XPP_share}\xz\gtk</td>
</tr>
</tbody>
</table>

   Later, each XPP client would be configured to use identical settings for these variables.
   
d. By default, the server install adds \{XPP_home\}\xz\bin to the %PATH% variable. You should change this to \(server\{XPP_share\}\xz\bin on the server, and later on the XPP clients as well.

2. If it exists, install the current XPP Service Pack.

3. If you are setting up secure access to XPP, see Establishing Secure Access (Optional) on page A-1 for post-installation steps.

   Even if you are not setting up secure access to XPP, see XPP Security Lock-Down Mode on page A-4, which can cause XPP to deny access to XyAdmin, and also deny edit access to style specs and jobs.

4. Complete the post-installation configuration (see Post-Installation Configuration on page 6-1).
Installing the XPP Client

To install XPP client:

1. Log in to the client as a local administrator.
   
   **Note:** Either UAC (User Account Control) must be completely turned off, or if UAC is enabled then if the system does not prompt to run setup.exe with Administrator permissions then you must cancel out of the install and then right-click on setup.exe and select Run as administrator.

   **Note:** On Windows Server 2012 (and later versions of Windows), turning UAC completely off is a two-step process. Setting UAC to Never notify via Change User Account Control settings in Action Center is only the first step needed to completely turn off UAC. After you do that step, User Account Control will still show as On in the Action Center panel. Check the web for instructions on how to complete the second step to modify the appropriate Local Security Policy via Server Manager to completely turn off UAC, so that User Account Control shows as Off in the Action Center panel. If you only complete step one, then Windows will not prompt to run setup.exe with Administrator permissions and will not run setup.exe with Administrator permissions and that will cause problems with the installation.

2. On the installation CD-ROM, click setup.exe, then right-click and choose “Run as administrator.”

3. In the Welcome panel, click Next.

4. In the License Agreement panel, read the software License Agreement, then click Yes.

5. In the Setup Type panel, click XPP Client, then click Next.

6. In the Choose Third-Party Software panel, accept the default selections and then click Next.

7. In the Enter Text panel, enter the XPP server name or IP address to which this client will connect, then click Next.

8. In the Choose Install Folder panel, specify the UNC path (for example, \\servername\{XPP_share\}) to the server location that contains the xz folder, then click Next.

9. In the Choose Style Files Folder panel, specify the UNC path (for example, \\servername\{XPP_share\}) to the server location that contains the sd_liz folder, then click Next.

10. In the Choose Destination Location panel, specify where to create the Perl folder. It is recommended that you accept the default location.

   **Note:** The installer will detect if Perl is already installed and display a dialog prompting you to indicate whether to continue installing Perl. Click No to cancel the Perl installation and continue the XPP installation. It is recommended that you do not install Perl over a previously installed instance.

   **Note:** When selecting a path, the installer will always append ”/Perl” to the path if it does not already end in ”/Perl”.


11. In the Start Copying Files panel, review your settings, then click Next to begin installing. The installer displays a progress bar showing the progress of the installation of XPP programs, and a dialog showing the status of the installation of third-party software.

12. The XPP install will continue with a cmd.exe window automatically opening to display the installation progress of the XPP-required Perl modules. After the modules are installed, press any key in the DOS window to complete this step and continue.

13. Click Yes, I want to restart my computer now, then click Finish.

14. Complete the post-installation configuration (see Post-Installation Configuration on page 6-1).
Overview

Before you proceed with these instructions, review these documents:

- SDL XPP Platform Requirements.
- SDL XPP Release Notes—This document contains late-breaking product information that might impact the XPP installation instructions in this manual.

These instructions apply to upgrading XPP only on computers that have an existing XPP installation in place. If XPP is not already installed on your server or client computer, see Installing XPP on page 3-1.

In this version of XPP, these third-party tools will be installed.

- Perl 5.16
- XPP Required Extra Perl Modules
- Reprise License Manager 12.2

Java

If you use Scalable Vector Graphics (SVG) images or publish using the Perl ePub module, you must install Oracle Java 1.6 or later, which you can download from java.oracle.com.
Upgrading from XPP 7.3 or earlier

Before you upgrade from XPP 7.3 or earlier, you must understand the XCS spec with regard to Unicode values, what effect it has on the conversion of data to 9.x, and what steps you must take to ensure that your data is properly converted. If you do not fully understand the procedures, do not proceed with the upgrade.

**Warning**

Do not open any XPP data, or run any conversion programs (such as cnv_tree) until you have updated the XCS spec with Unicode values.

During upgrade and planning, you may contact SDL to evaluate your current XCS spec. There is no fee for this consultation. During upgrade and planning, you may contact SDL to evaluate your current XCS spec. There is no fee for this consultation. For assistance, log a support ticket using the Customer Support Gateway (https://gateway.sdl.com).

Upgrading the XCS Spec

XPP 9.x is Unicode-based and uses the XCS/Unicode mappings in the _xcs_default.sde spec to convert XPP Style documents and XCS numbers to Unicode. XPP delivers a new version to %XYV_STYLES%/xlibrary/Lsyslib, but does not copy it into place on an upgrade because you may have customized this spec.

Depending on your XPP environment and current XCS, you may need to modify your XCS or leave your existing XCS as is. Once data is converted, it cannot be undone nor re-converted. Therefore, it is best to understand the impact before you convert.

1. Upgrade XPP on your XPP server. Complete the installation program on the CD, but do not proceed to configuring your server, client, or stand-alone system.

2. At a command prompt, type %XYV_EXECS%/procs/sc/upgradexcs.pl

   This program compares the 9.x XCS spec against any previously known versions of XCS on your system to determine if you have made any character changes to the spec.

3. Do one of the following:
   - If there are no changes, you are asked to copy the new 9.x XCS Spec into %XYV_STYLES%/Lsyslib.
   - If you have made changes, the program displays a dialog box containing the differences, saves the results to a file as %XYV_TMPS%/xcsdiff.txt, and provides an option to overwrite the current file with a warning that you must manually add the differences to the new XCS spec.
4. Do one of the following:
   - If you have only made a few changes to your XCS Spec, select the option to overwrite your spec.
     The program makes a backup of your original XCS Spec before overwriting it with the 9.x XCS Spec, then asks to run genxcs.

   Note: Should you run the program more than once, upgradexcs.pl saves the file as %XYV_STYLES%\Lsyslib\_xcs_pre90-X.sde (where the program increments X each time you run it.)

   - If you have made many changes, at a command prompt, type

     `%XYV_EXECS%\procs\sc\update_xcs.pl -gui`

     The program opens a dialog box that steps you through the process of merging our proposed Unicode/XCS values into your XCS default Spec.

   Note: This process is more complex than just running upgradexcs.pl. You may prefer to receive assistance from SDL Professional Services.

Upgrading XPP Servers

Perform this procedure on XPP servers. To upgrade XPP clients, see Upgrading XPP Clients on page 5-6.

1. If your installation is prior to XPP 9.0, you must obtain and install a new license file (see Obtaining a License on page 2-4).

2. If you are upgrading from a version of XPP prior to 9.0, you must uninstall ActivePerl before upgrading.
   Before you uninstall ActivePerl, first make a note of any user-defined extra modules you have installed into the site library and be prepared to reinstall these modules after installing XPP.
   If you are upgrading from XPP 8.2 or later, you do not have to uninstall any other third-party software.

3. Log in as a local administrator.

   Note: Either UAC (User Account Control) must be completely turned off, or if UAC is enabled then if the system does not prompt to run setup.exe with Administrator permissions then you must cancel out of the install and then right-click on setup.exe and select Run as administrator.

   Note: On Windows Server 2012 (and perhaps later versions of Windows), turning UAC completely off is a two-step process. Setting UAC to Never notify via Change User Account Control settings in Action Center is only the first step needed to completely turn off UAC. After you do that step, User Account Control will still show as On in the Action Center panel. Check the web for instructions on how to complete the second step to modify the appropriate Local Security Policy via Server Manager to completely turn off UAC, so that User Account Control shows as Off in the Action Center panel. If you only complete step one, then Windows will not prompt to run
Upgrading XPP Servers

*setup.exe with Administrator permissions and will not run setup.exe with Administrator permissions and that will cause problems with the installation.*

4. Download and mount the installation ISO file. To mount an ISO file, right-click on the file and select **Mount**. Windows mounts the ISO file to the next available drive letter. Alternatively, you can use a third-party tool to mount the ISO as a disk.

5. On the installation media, double-click **setup.exe**.

6. In the Welcome panel, click **Next**.

7. In the License Agreement panel, read the software License Agreement, then click **Yes**.

8. In the Introduction panel, click **Next**.

9. In the Setup Type panel, click **Server**, then click **Next**.

10. In the Choose Third-Party Software panel, select the desired options and click **Next**.

    **Note:** If installing or upgrading to XPP 9.2, you must include **License Manager** among the options you select. Reprise License Manager version 12.2 will be installed if it has not already been installed for other SDL products.

11. In the Choose Language panel, click the language in which you want XPP messages to display, then click **Next**.

12. Read the message about the XCS Spec, then click **Yes**.

    **Note:** Send your XCS spec to SDL for evaluation before upgrading from XPP 7.3 or earlier to 9.x (see Upgrading the XCS Spec on page 5-2). Do not proceed with configuring the server system before you have completed this step.

13. In the Choose Install Folder panel, confirm the path to the **xz** folder, and then click **Next**.

14. In the Choose Style Files Folder panel, confirm the path to the **sd_liz** folder, and then click **Next**.

15. In the Choose Destination Location panel, specify where to create the **Perl** folder. It is recommended that you accept the default location.

    **Note:** The installer will detect if Perl is already installed and display a dialog prompting you to indicate whether to continue installing Perl. Click **No** to cancel the Perl installation and continue the XPP installation. It is recommended that you do not install Perl over a previously installed instance.

    **Note:** When selecting a path, the installer will always append “/Perl” to the path if it does not already end in “/Perl”.

16. In the Start Copying Files panel, review your settings, then click **Next** to begin installing

17. The XPP upgrade will continue with a **cmd.exe** window automatically opening to display the upgrade progress of the XPP-required Perl modules. After the modules are installed, press any key in the DOS window to complete this step and continue.
18. In the Do you have a license file to install? dialog, click Yes.
19. Enter the license file path name and click Next.
20. In the Multiprocessor Check window, click Next.
21. If prompted, click Yes, I want to restart my computer now.
22. Click Finish.

Post-Upgrade Tasks
1. If it exists, install the current XPP Service Pack.
2. If upgrading from 7.3 or earlier, you may need to upgrade your XCS spec (see Upgrading the XCS Spec on page 5-2).
3. Complete the post-installation configuration (see Post-Installation Configuration on page 6-1).
4. If upgrading from a version of XPP prior to 9.2, remove MKS Toolkit and MKS X/Server, which are not required by XPP version 9.2 and later.
Upgrading XPP Clients

Perform this procedure on XPP clients. To upgrade XPP servers, see Upgrading XPP Servers on page 5-3.

1. If you are upgrading from a version of XPP prior to 9.0, you must uninstall ActivePerl.

   Before uninstalling ActivePerl, first make a note of any user-defined extra modules you have installed into the site library and be prepared to reinstall these modules after installing XPP.

   If you are upgrading from XPP 8.2 or later, you do not have to uninstall any other third-party software.

2. Log in as a local administrator.

   Note: Either UAC (User Account Control) must be completely turned off, or if UAC is enabled then if the system does not prompt to run setup.exe with Administrator permissions then you must cancel out of the install and then right-click on setup.exe and select Run as administrator.

   Note: On Windows Server 2012 (and perhaps later versions of Windows), turning UAC completely off is a two-step process. Setting UAC to Never notify via Change User Account Control settings in Action Center is only the first step needed to completely turn off UAC. After you do that step, User Account Control will still show as On in the Action Center panel. Check the web for instructions on how to complete the second step to modify the appropriate Local Security Policy via Server Manager to completely turn off UAC, so that User Account Control shows as Off in the Action Center panel. If you only complete step one, then Windows will not prompt to run setup.exe with Administrator permissions and will not run setup.exe with Administrator permissions and that will cause problems with the installation.


4. In the Welcome panel, click Next.

5. In the License Agreement panel, read the software License Agreement, then click Yes.

6. In the Introduction panel, click Next.

7. In the Setup Type panel, click Client, then click Next.

8. In the Choose Third-Party Software panel, you do not need to select third-party products if you upgrading from XPP 9.0; otherwise, select all third-party products (except the license manager) and then click Next.

9. In the Enter Text panel, enter the XPP server name or IP address to which this client will connect, then click Next.

10. In the Choose Install Folder panel, specify the UNC path (for example, \servername\{XPP_share}) to the server location that contains the xz folder, then click Next.
11. In the Choose Style Files Folder panel, accept the defaults, or specify the UNC path (for example, `\servername\{XPP_share}`) to the server location that contains the `sd_liz` folder, then click **Next**.

12. In the Choose Destination Location panel, specify where to create the `Perl` folder. It is recommended that you accept the default location.

   **Note:** The installer will detect if Perl is already installed and display a dialog prompting you to indicate whether to continue installing Perl. Click **No** to cancel the Perl installation and continue the XPP installation. It is recommended that you do not install Perl over a previously installed instance.

   **Note:** When selecting a path, the installer will always append `/Perl` to the path if it does not already end in `/Perl`.

13. In the Start Copying Files panel, review your settings, then click **Next** to begin installing.

14. The XPP upgrade will continue with a `cmd.exe` window automatically opening to display the upgrade progress of the XPP-required Perl modules. After the modules are installed, press any key in the DOS window to complete this step and continue.

**Post-Upgrade Tasks**

1. Complete the post-installation configuration (see Post-Installation Configuration on page 6-1).

2. If upgrading from a version of XPP prior to 9.2, remove MKS Toolkit and MKS X/Server, which are not required by XPP version 9.2 and later.
Upgrading XPP Clients
Chapter 6

Post-Installation Configuration

Locating the Latest Configuration Files and Specs

Each release of XPP software includes changes to default configuration files, setup specs, and style specs.

When you install XPP for the first time, the installation program copies the default files and specs directly into their destination directories and libraries so the XPP software can access them. However, if you add a patch to this newly installed version of XPP, you need to review the specs to determine what has changed and whether you need to copy over any files or specs.

On an existing system, since users often modify the default configuration files and specs to reflect the needs of their site, the installation program does not overwrite these files and specs (with a few exceptions noted in the following tables) when you upgrade a system from a previous version of XPP. Instead, the installation program places the default files and specs in distribution directories, as shown in the following table. You must replace or modify the existing configuration files and specs in the destination directories if you want to take advantage of changes introduced by the most recent XPP release.

*Note:* You do not need to copy over files for every release. Check the SDL XPP Release Notes to determine what files have been modified for this release.

Distribution and Destination Directories

For upgrade installations, the XPP installation leaves the files in the distribution directories (with a few exceptions noted in the following tables). After the upgrade installation is complete, you must modify or replace existing configuration files and specs to take advantage of changes introduced by the XPP release. With new installations, XPP moves the files to their destination directories. The following table lists the names of the default files, their function, the distribution directories to which they are delivered when
you upgrade your XPP system, and the destination directories whose files you need to modify or replace if you want XPP to use the latest enhancements. A few files are written directly to their destination directories and if customized will be overwritten on an upgrade.

Table 6-1: Distribution and Destination Directories

<table>
<thead>
<tr>
<th>Files</th>
<th>Function</th>
<th>Delivered To/Destination Directory</th>
</tr>
</thead>
</table>
| xyview.ini | Customizes attributes of the XyView window, including initial size, location, and behavior. | Delivered to: %XYV_EXECS%distr\sys-config  
Destination: %XYV_EXECS\sys\config  
or your home directory. Values in the files in your home directory take precedence over system files. Therefore, it is only necessary to specify values in the resource file in your home directory that are different from those in the system-level file. |
| xyview.gtkrc | Customizes the look and feel of the XyView window and sets the color and font of the X-Menu buttons. | Delivered to: %XYV_EXECS%distr\sys-config  
Destination: %XYV_EXECS\sys\config  
or your home directory. Values in the files in your home directory take precedence over system files. Therefore, it is only necessary to specify values in the resource file in your home directory that are different from those in the system-level file. |
| sdedit.ini | Customizes attributes of the Sdedit window, including initial size, location, and behavior. | Delivered to: %XYV_EXECS%distr\sys-config  
Destination: %XYV_EXECS\sys\config  
or your home directory. Values in the files in your home directory take precedence over system files. Therefore, it is only necessary to specify values in the resource file in your home directory that are different from those in the system-level file. |
### Table 6-1: Distribution and Destination Directories

<table>
<thead>
<tr>
<th>Files</th>
<th>Function</th>
<th>Delivered To/Destination Directory</th>
</tr>
</thead>
</table>
| sdedit.gtkrc  | Customizes the look and feel of the Sdedit window.                      | Delivered to: %XYV_EXECS%distr\sys-config  
|               |                                                                          | Destination: %XYV_EXECS\sys\config  
|               |                                                                          | or your home directory. Values in the files in your home directory take precedence over system files. Therefore, it is only necessary to specify values in the resource file in your home directory that are different from those in the system-level file. |
| ps_ctrl      | Sets screening and other PostScript output parameters of TIFF contone, EPS, JPEG, PDF, SVG, CGM, PNG, BMP, and GIF images. | Delivered to: %XYV_EXECS%distr\sys\od  
|               |                                                                          | Destination: %XYV_EXECS\sys\od       |
| trays.ps     | File that you send to a particular printer using a standard lpr or other print command in order to get a list of available tray names for setting up the tray control file. | Delivered to: %XYV_EXECS%distr\sys\od  
|               |                                                                          | Destination: %XYV_EXECS\sys\od       |
| Setup specs (for example, sap config, bgq config, im config) | Defines the environment for XPP applications, including autoprocessing, print and process queues, graphics, and backup utilities. | Delivered to: %XYV_EXECS%distr\sys-config  
|               |                                                                          | Destination: %XYV_EXECS\sys\config    |
| DOF specs    | Device options files set options for queues defined in the background queues spec. Used to create printer profiles. | Delivered to: %XYV_EXECS\spool\distr-xz  
|               |                                                                          | Destination: %XYV_EXECS\sys\spool\bgq-xz  
| default rollfed sheetfed | Tray control files for default, rollfed, and sheetfed devices. | Delivered to: %XYV_EXECS%distr\sys\od\ps_page  
|               |                                                                          | Destination: %XYV_EXECS\sys\od\ps_page  

### Table 6-1: Distribution and Destination Directories

<table>
<thead>
<tr>
<th>Files</th>
<th>Function</th>
<th>Delivered To/Destination Directory</th>
</tr>
</thead>
</table>
| X-menu         | Allows users to access XPP keyboard functions without using the keyboard. Also known as the “XButtons menu.” | Delivered to: %XYV_EXECS%/distr/sys-config  
Destination: %XYV_EXECS%/sys/config  
or the user’s home directory. Files in the user’s home directory take precedence over system files. |
| 1col           | Graphics that are used in XPP environments jobs.                           | Delivered to: %XYV_EXECS%/distr/graphics  
Destination: User-definable graphics libraries                                      |
| 2col           |                                                                         |                                                                                                      |
| 3col           |                                                                         |                                                                                                      |
| land           |                                                                         |                                                                                                      |
| land3          |                                                                         |                                                                                                      |
| port           |                                                                         |                                                                                                      |
| part.tif       | Sample graphics files in TIFF, PostScript, and EPS format.                | Delivered to: %XYV_EXECS%/distr/graphics  
Destination: User-definable graphics libraries                                      |
| desk.ps        |                                                                         |                                                                                                      |
| terminal.eps   |                                                                         |                                                                                                      |
| Style specs    | Default versions of specs used by XPP that control document styles, fonts, color, conversion, and composition and pagination parameters.  
Note: _kb_0.sde and _xy_sys.sde are delivered directly to Lsyslib, and if customized they will be overwritten on an upgrade. | Delivered to: %XYV_STYLES%/xlibrary  
Llibrary, Klibrary, Xlibrary  
Destination: %XYV_STYLES%/Llibrary, Klibrary, Xlibrary |
| Translation tables |                                                                     |                                                                                                      |
| Keyboard maps  |                                                                         |                                                                                                      |
| Kerning pairs  |                                                                         |                                                                                                      |
| Font width specs for standard 35 |                                                                    |                                                                                                      |
| PostScript fonts |                                                                     |                                                                                                      |
| table_1        | PostScript font download table.                                         | Delivered directly to destination: %XYV_EXECS%/sys/od/ps_dlf\tables                                      |
| extended       | PostScript font encoding table.                                         | Delivered directly to destination: %XYV_EXECS%/sys/od/ps_dlf\encodings                                   |
### UNC Format

This section applies only if you intend to have XPP clients of this XPP server.

### Document Paths

If you chose a location other than the default path of the `xz` and `sd_liz` directories, the installation program installs the software to the specified locations using the local drive letters. Your server would find the necessary path information and location of data, but the client machines would not.

1. In Windows, click **Start > Programs > XyEnterprise > XML Professional Publisher > XPP > Administrative Tools.**
2. Click **File > Document Paths.**
3. In the **Job Handle** list box, select the handle to edit.
4. Change the `{XPP_home}` prefix of the job handle to the `\\servername\\{XPP_share}` prefix. Do this for each job handle.
5. Click **Set.**
6. Click **Apply.**

---

### Table 6-1: Distribution and Destination Directories

<table>
<thead>
<tr>
<th>Files</th>
<th>Function</th>
<th>Delivered To/Destination Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>extended</td>
<td>PDF font encoding table. Note: If customized, this file will be overwritten on an upgrade.</td>
<td>Delivered directly to destination: %XYV_EXECS%\psres\encodings</td>
</tr>
<tr>
<td>Cousine.ttf</td>
<td>TrueType fonts used to support Sedit and the XyView Line Editor.</td>
<td>Delivered to: %XYV_EXECS%\xfonts</td>
</tr>
<tr>
<td>vuem.ttf</td>
<td></td>
<td>Destination: %WINDIR%\Fonts</td>
</tr>
<tr>
<td>XYmono.ttf</td>
<td></td>
<td></td>
</tr>
<tr>
<td>_sep_ps.sde</td>
<td>Color separation specs for tints, patterns and gradient fills</td>
<td>Delivered to: %XYV_STYLES%\xylibrary\Lsyslib</td>
</tr>
<tr>
<td>_sep_pdf.sde</td>
<td></td>
<td>Destination: %XYV_STYLES%\Lsyslib</td>
</tr>
<tr>
<td>_sep_level1.sde</td>
<td>Lets you obtain color separation using the –sep level1 option for the output driver.</td>
<td>Delivered to: %XYV_STYLES%\xylibrary\Lsyslib</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Destination: %XYV_STYLES%\Lsyslib</td>
</tr>
</tbody>
</table>
Environment Variables

If XPP is running under a server/clients model, ensure the following environment variables are set correctly:

1. Click **Start**.
2. In the **Search programs and files** type-in field, enter **path**.
3. Click **Edit the system environment variables**.

   The **Environment Variables** pane opens.

   **Note:** These steps may differ slightly, depending on your version of Windows.

Table 6-2: Environment Variables

<table>
<thead>
<tr>
<th>Environment Variable</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>%XYV_EXECS%</td>
<td><code>\servername\{XPP_share}\xz</code></td>
</tr>
<tr>
<td>%XYV_STYLES%</td>
<td><code>\servername\{XPP_share}\sd_liz</code></td>
</tr>
<tr>
<td>%PSRESOURCEPATH%</td>
<td><code>\servername\{XPP_share}\xz\psres</code></td>
</tr>
<tr>
<td>%PATH%</td>
<td><code>C:\Perl\site\bin;C:\Perl\bin;C:\ProgramData\Oracle\Java\javapath;C:\Windows\system32;C:\Windows\System32\Wbem;C:\Windows\System32\WindowsPowerShell\v1.0\;\servername\{XPP_share}\xz\bin</code></td>
</tr>
<tr>
<td>%GTK_DATA_PREFIX%</td>
<td><code>\servername\{XPP_share}\xz\gtk</code></td>
</tr>
<tr>
<td>%GTK_EXE_PREFIX%</td>
<td><code>\servername\{XPP_share}\xz\gtk</code></td>
</tr>
</tbody>
</table>

**Note:** The `%XYV_TMPS%` variable is usually set to the local machine’s Windows temp folder, `%WINDIR%\temp`. If the variable needs to be shared, set its value to `\servername\{XPP_share}\temp` instead.

Graphics Paths

If XPP is running under a server/clients model, ensure the following graphics paths are set correctly:

1. Click **Start > All Programs > XML Professional Publisher > XPP > Administrative Tools**.
2. Click **File > Graphics Configuration**.

   The **Master im config** pane opens.

Table 6-3: Graphics Libraries

<table>
<thead>
<tr>
<th>Initial Library Path</th>
<th>New Library Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>%XYV_EXECS%\distr\graphics</td>
<td><code>\servername\{XPP_share}\xz\distr\graphics</code></td>
</tr>
<tr>
<td>C:/XPP/glibs/$(XYV_LIBNAME)</td>
<td><code>\servername\{XPP_share}\glibs\$(XYV_LIBNAME)</code></td>
</tr>
</tbody>
</table>
Configuring the Command Window

If you have configured XPP to display composition messages in a language that uses accented characters, you may need to change the code page associated with the command window to ensure such characters are correctly displayed.

The command `chcp 65001` associates code page 65001, containing Unicode characters, with the command window. Either enter this command at the command prompt before running XPP compose, or create a shortcut to open the command window with the correct code page such as the following:

```cmd
cmd /K chcp 65001
```

Use this shortcut each time you open the command window to ensure composition messages are displayed using Unicode encoding.

Configuring System Processes

*Note: This configuration is required only if you selected Auto-processing during the installation.*

Once you have successfully installed XPP on the server, set up the following XPP and system processes needed at your site:

- Background processing
- Auto-processing: create an auto-processing directory
- Graphics: create a graphics directory
- Document paths: the first document path is created by the installation

You configure XPP processes using the XPP Administration Tool (XyAdmin). For additional information on accessing XyAdmin or configuring the system processes, see the *XML Professional Publisher: Managing XPP* publication. Also, see Completing an Upgrade of XPP Server on page 6-8.

Configuring Print Direct to PDF (Upgrade Only)

Before you can use the *Print direct to PDF* option from XPP, you must convert the encoding files for PostScript Type 1 fonts, and also ensure that they have Adobe Font Metrics (.afm) font descriptions.

*Note: This is a separately licensed feature.*

*Note: This task is for upgrades only, and not required after a new XPP installation.*

From the command line, enter `%XYV_EXECS%\procs\sc\pdfsetup.pl`
Completing an Upgrade of XPP Server

If you are upgrading from XPP 7.3 or earlier, you may want to convert your documents and style libraries for the conversion to Unicode values after you install the XPP software.

**Warning**: *Do not open any XPP data, or run any conversion programs (such as cnv_tree) until you have updated the XCS Spec with Unicode values.*

You may convert all of your documents and styles to run on this version of XPP at this time, or you can allow XPP to convert each division and style file individually as you open it for the first time in this version of XPP.

Even after XPP 7.3 there are a few other database conversions that apply, so even if you are upgrading from version XPP 8.x you may want to run cnv_tree to convert all the data up front.

Converting Data

XPP converts each division and style file when you access it through composition or the XyView.

You can convert jobs or style files directly using the cnv_tree utility. Because data conversion can take a long time, SDL recommends that you convert your jobs when they are not being used, for example, at night or on a weekend.

See [XML Professional Publisher: Command Line Utilities](#) for more information on the cnv_tree utility.

If all of your jobs are located under the same document root handle, you can run cnv_tree from the document root handle to convert all data.

If your jobs are located under different paths, you have to change directories to the root handle of the job you want to convert (or to any part of the job hierarchy under the handle to convert from that point down only) before running cnv_tree.

Similarly, if all your spec libraries are located under the same top-level folder, you can run cnv_tree from that folder to convert all specs. If your spec libraries are located under different paths, you must change folder to each location of the library whose specs you want to convert before running cnv_tree.

To convert data and specs:

1. Change to the location of the job or library whose specs you want to convert.
   
   If you are
   
   • at the document root handle or top-level spec library, cnv_tree converts all the data below.
   • in a specific job or library, cnv_tree converts all the divisions of that particular job, or all the specs in that library.
   • in a division, cnv_tree converts only that division.
2. Enter the following command at the command line prompt:

   `cnv_tree`

   This utility converts your divisions and local specs to run on XPP. For more information, run the following command in a terminal window: `xyhelp cnv_tree`

---

Converting Xresources to GTK Resources

XPP 9.2 and later for the Windows platform replaces XMotif technology with native Windows support. Consequently, the format of the resource files has changed. If you are upgrading from an earlier version of XPP, you can convert existing `Sdedit` and `XYwyg` Xresource files, which control the look and behavior of the Sdedit and XyView windows, respectively, into their new counterparts, `sdedit.ini` and `xyview.ini`. Converting these files allows you to preserve most XyView and Sdedit configuration settings from your previous XPP installation.

A Perl utility, `xpp2gtkresources.pl`, is delivered to `%XYV_EXECS%\procs\util` and can be run from the command line by a user with Administrator permissions to convert existing Xresource files into their equivalent resource files.

Conversion Utility Syntax

To run the conversion utility, enter the following command at the command line in the directory containing the `xpp2gtkresources.pl` program:

```
Perl xpp2gtkresources.pl –in input_filepath –out output_filepath
[-X] [-debug]
```

The following table describes the arguments and options for the utility:

<table>
<thead>
<tr>
<th>Argument/Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-in</code></td>
<td>Required. The full path to the Sdedit or XyWyg Xresource file to be converted.</td>
</tr>
<tr>
<td><code>-out</code></td>
<td>Required. The full path to the sdedit.ini or xyview.ini resource file to be created.</td>
</tr>
<tr>
<td><code>-X</code></td>
<td>Optional. Generate extra output messages.</td>
</tr>
<tr>
<td><code>-debug</code></td>
<td>Optional. Generate extra output.</td>
</tr>
</tbody>
</table>
Installing the Shakespeare CSS Demo

In addition to the existing Shakespeare demo, which is based on the Item Format spec, you can also install the same demo based on CSS.

From the command line, enter `%XYV_EXECS%\procs\sc\samples.pl` when it completes, an XPP "job" will be installed to:

`CLS_xyvision\GRP_comp\JOB_shakesp_css` on the first document handle that contains `CLS_xyvision/GRP_comp`.
Chapter 7
Performing a Silent Installation or Upgrade

Silent Installation/Upgrade

You can install or upgrade the XPP server and client without user interaction by running an installation in “record” mode, setting the desired default installation location, the features to be installed, and other configuration options. The resultant .iss file can be used to run a pre-configured installation or upgrade silently on other XPP servers.

Running the Installer in Record Mode

To create an installation file, execute the installer using the /r (record) command switch to capture your responses to the installation prompts. These responses will be saved to a file that can be used to install XPP with the same configuration.

To run the installer in record mode, at the command line, enter:

```
setup.exe /r /f1"\path\file.iss" /f2"\path\file.log"
```

where \path\file.iss is the path and file name of an .iss type file containing the configuration to be used for the installation and \path\file.log is the path and file name of the installation log file to be created by the installer. The /r switch causes the system to record your responses in a form that is replayable on other systems.

The installation configuration file is a text file with the capture of all of the installation steps. After it has been recorded, the file can be modified using a text editor to change the values entered in response to the installation prompts, for example to change the locations of XPP directories and files when the configuration file is used in playback mode to perform an installation.

Optional Arguments for the setup.exe Command

You can add one or more optional arguments to the setup.exe command to:

- create an additional, XPP-specific log file
- specify the location of the PERL installation
- specify the locations of the \texttt{xz} and \texttt{sd\_liz} directories

The following table describes each of the optional arguments you can use with the \texttt{setup.exe} command.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG</td>
<td>Creates an additional log file containing XPP-specific information in the location you specify. This value can be any valid path and file name. If you do not use this argument, no XPP-specific log file will be created.</td>
<td>\texttt{LOG=drive:}\texttt{/path_to_file.log} where \texttt{drive} is the drive where the log file is to be created and \texttt{path_to_file.log} is the file path and name of the additional log file containing.</td>
</tr>
<tr>
<td>PERL</td>
<td>Specifies the location of the PERL installation. Typically this value is C:\PERL.</td>
<td>\texttt{PERL=drive:}\texttt{/perlpath} where \texttt{drive} is the drive and \texttt{perlpath} is the path where PERL is to be installed.</td>
</tr>
<tr>
<td>XZ</td>
<td>Specifies the location of the \texttt{xz} directory. Typically this value is C:\XPP.</td>
<td>\texttt{XZ=drive:}\texttt{/path_to_xz_parent} where \texttt{drive} is the drive and \texttt{path_to_xz_parent} is the path where the \texttt{xz} directory is to be located.</td>
</tr>
<tr>
<td>SDLIZ</td>
<td>Specifies the location of the \texttt{sd_liz} directory. Typically this value is C:\XPP.</td>
<td>\texttt{SDLIZ=drive:}\texttt{/path_to_sd_liz_parent} where \texttt{drive} is the drive and \texttt{path_to_sd_liz_parent} is the path where the \texttt{sd_liz} directory is to be located.</td>
</tr>
</tbody>
</table>

The following example shows the syntax for running \texttt{setup.exe} in record mode with paths specified for PERL, \texttt{xz}, and \texttt{sd\_liz}:

\begin{verbatim}
setup.exe /r /f1"w:\xpp\net\cdrom\embedded_server.iss"
/f2"e:\data\xpp\install\record-mode.log" PERL="e:\perl"
XZ="e:\apps\xpp" SDLIZ="e:\data\xpp" LOG="e:\data\xpp\install.log"
\end{verbatim}

\textbf{Note:} The value specified for each of these arguments must be enclosed in double quotes, and should be full file path, including the drive.

If you use an argument to specify a path for Perl, \texttt{xz} or \texttt{sd\_liz} in record mode, that path is not written to the installation configuration file and the installer will not prompt for that path when the file is used to execute a silent install. You must therefore use the same argument during playback to specify a path. The path you specify during playback can be different from that entered during recording.

\textbf{Note:} When performing a silent install with an installation configuration file recorded using any of the optional arguments, you must use the same argument(s) during playback. Failure to do so will cause the installer to fail with an error.
The following is one example of the syntax you could use to run `setup.exe` in playback mode using the installation configuration file created by the previous example:

```
setup.exe /s /f1"w:\xpp_net_cdrom\embedded_server.iss"
/f2"c:\data\silent_install.log" PERL="c:\Perl" XZ="c:\apps\xpp"
SDLIZ="c:\data\xpp" LOG="c:\data\xpp_install.log"
```

In this example, the paths are similar to those of the original, recorded installation, but use the `c:` drive instead of the `e:` drive to install XPP on a workstation without an `e:` drive.

**Sample Installation Configuration File**

The following is a sample recorded installation configuration file that installed XPP server (into `C:\XPP`), Perl (into `C:\XPP\Perl`), Extra Perl Modules, and the License Manager. Note the paths in the file and how they can be edited to specify different installation locations. These are marked with `//NOTE`. However, the `//NOTE` should not be included in result file.

```
Note: If the Perl, xz, and sd_liz locations had been specified as arguments for setup.exe during recording, these paths would not appear in the installation configuration file.

[InstallShield Silent]
Version=v7.00
File=Response File
[File Transfer]
OverwrittenReadOnly=NoToAll
[{B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD}-DlgOrder]
Dlg0=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdWelcome-0
Count=11
Dlg1=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdLicense-0
Dlg2=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdSetupTypeEx-0
Dlg3=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdComponentTree-0
Dlg4=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-AskOptions-0
Dlg5=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdAskDestPath-0
Dlg6=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdAskDestPath-1
Dlg7=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdAskDestPath-2
Dlg8=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdStartCopy-0
Dlg9=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdShowInfoList-0
Dlg10=(B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD)-SdFinish-0
[{B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD}-SdWelcome-0]
Result=1
[{B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD}-SdLicense-0]
Result=1
```
Silent Installation/Upgrade

```plaintext
[[B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD]-SdSetupTypeEx-0]
Result=Server

[[B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD]-SdComponentTree-0]
szDir=C:\XPP\Component-type=string
Component-count=6
Component-0=Programs
Component-1=GUIPrograms
Component-2=Ms Support Files
Component-3=Perl
Component-4=PerlModules
Component-5=Reprise
Result=1

[[B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD]-AskOptions-0]
Result=1
Sel-0=1
Sel-1=0
Sel-2=0
Sel-3=0

[[B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD]-SdAskDestPath-0]
szDir=C:\XPP
// NOTE: This is the XPP "xz" location
Result=1

[[B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD]-SdAskDestPath-1]
szDir=C:\XPP
// NOTE: This is the XPP "sd_liz" location
Result=1

[[B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD]-SdAskDestPath-2]
szDir=C:\XPP\Perl
// NOTE: This is the PERL install location
Result=1

[[B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD]-SdStartCopy-0]
Result=1

[Application]
Name=XML Professional Publisher
Version=9.2
Company=XyEnterprise
Lang=0409
```

7-4 Performing a Silent Installation or Upgrade SDL XPP Installation and Upgrade Guide for Windows
Running the Installer in Silent Mode

To perform a silent installation using the previously recorded installation configuration file, execute the installer using the /s (playback) switch.

To run the installer in playback mode, at the command line, enter:

```
setup.exe /s /f1"\path\file.iss" /f2"\path\file.log"
```

where \path\file.iss is the path and file name of the .iss file that was previously recorded using the /r switch and \path\file.log is the path and file name of the installation log file.

The /f1 switch takes the file name and path of the recorded file without a space between the switch and the name of the file. Also, double quotes must be used if there are spaces in the path name.

When the silent install is completed, a setup.log file is written to the same folder as the location of the installation configuration file. This log file contains information about the install. If the install was successful, the file contains the following:

ResultCode=0.

If there are other error numbers, it usually means that the response file received unknown dialog boxes when the playback file was run.

The user cannot base the success on any sort of program return code when starting the setup.exe installation program.

**Note:** If the XPP silent installer is run from within another installation program, the caller should wait for the task to complete. If the XPP silent installer is run from a cmd.exe window, the setup command will return immediately with the installation run in the background. To wait for the install to complete, use the following command:

```
start /wait setup.exe /s /f1"\path\file.iss"
```

**Note:** When playing back a silent installation, the user is not asked for the location of the license file. You must copy a valid license file (*.lic) into the C:\Program Files (x86)\Xyenterprise\SDL_License directory. The installer will not do this.

**Note:** If a path for PERL, xz, or sd_liz was specified as an argument for the setup.exe command during recording, the installer will not prompt for that path when the resultant installation configuration file is used to execute a silent install. You must therefore use the same argument during playback to specify a path, which can be different from the one entered while recording.

Sample Installation Log File

The following is a sample log file created by the installer:

```
Result=1
[{B35BFDA9-FA56-478D-AFA2-9F759A1CA2CD}-SdFinish-0]
Result=1
bOpt1=0
bOpt2=0
```
[InstallShield Silent]
Version=v7.00
File=Log File

[ResponseResult]
ResultCode=0

[Application]
Name=XML Professional Publisher
Version=9.2
Company=XyEnterprise
Lang=0409

After the log file is created, the status of the installation is reported in the [ResponseResult] section in the ResultCode entry. A result code of 0 (as in the example shown here) signifies that the installation was successful. Other values indicate an error.
Appendix A

Establishing Secure Access (Optional)

This appendix assumes system administrator knowledge. It describes how to set up the necessary groups and permissions for establishing secure access to XPP. Establishing secure access to XPP is optional.

Assumptions and Recommendations

This section assumes the following about your environment setup:

- You are installing XPP in an existing computing environment with established users and groups used for other applications.
- Your site wants only authorized individuals to use and access XPP software and data.
- Your site does not want multiple user logins for different applications—any user who logs in should be able to run all the applications the user is authorized to run.

Because users and groups, who are registered only on a particular Windows workstation or server, are so limited, SDL recommends that all users and groups be configured as Domain users and groups.

System Default Configuration

Ensure that XPP application and data servers are physically secure and protected against unauthorized access via User Rights and Policies. Also ensure that all drives in your Windows domain are formatted as NTFS. Remove “Everyone” privileges from all resources (drivers, printers, etc.), substituting “Authenticated Users” or other desired group(s). If desired, you can set up an XPP users login script that automatically runs when the users log on.
XPP and Security

This section describes establishing XPP security on Windows platforms on two levels: file permissions and application permissions.

XPP file permissions are set up with a domain local user group. Only users included in the group can execute the XPP application and access XPP data. However, there is no distinction between user group members regarding their permissions within the XPP application.

XPP application permissions are set up with application groups named xyadmin, xystyle, and xyjstyle. Although you create and add users to these groups on the Windows domain, their permissions are defined in the XPP application itself.

Pre-Installation Configuration
Before you install XPP, set up file permissions for the XPP data as follows:

1. Create a domain local group for your XPP users.
   
   Note: The examples in this and the following section use the group name xppusers but you can use any valid group name.

2. Add all XPP users and the Domain Administrator account to this XPP user group xppusers. If you have a user account for SDL Technical Support personnel to use for remote diagnostics, include this account in the group as well.

3. Log in as an xppusers group member with administrative privileges, then install the XPP software according to the procedure in Installing XPP on page 4-1.

4. Note the following recommendations:
   
   • Install XPP and its accompanying third-party products to a drive that contains enough free space to hold the software and XPP data.
   
   • Share the XPP paths for access by XPP clients and define correct share permissions for the xppusers group.
   
   • Ensure that all clients map XPP shares to the same drive letters or else use UNC pathing exclusively.

Post-Installation Configuration
After you install XPP, do the following:

1. Configure the Auto-processing and Background-processing services on the XPP server(s).

2. Remove Everyone permissions from all XPP paths.

3. Give the XPP users’ group xppusers full permissions. Check the boxes for both files and subdirectory.

   Steps 2 and 3 restrict access to XPP applications and data to members of the xppusers group only.
4. To further control XPP access, you can set up the xyadmin, xystyle, xyjstyle, and xyperuse groups with appropriate members (see Special Windows Groups and XPP Permissions on page A-3).

Special Windows Groups and XPP Permissions

XPP defines and manages application permissions through Windows groups named xyadmin, xystyle, xyjstyle, and xyperuse. These groups have the following XPP application permissions:

- **xyadmin**
  Group members can run XPP administrative tools and modify XPP style files at either the system library or the local job level. If you establish this group, include your Windows system administrator as a member.

- **xystyle**
  Group members can modify XPP style files at either the system library or local job level.

- **xyjstyle**
  Group members can modify style files at the local job level only.

- **xyperuse**
  Group members have read-only permissions for designated divisions. This group is applicable only if your site has purchased the Peruse option.

When you create a group, XPP restricts access to the tools, libraries, and specs to users of that group. If you do not create the groups, no XPP restrictions apply.

For example, if you create the xyadmin group, a user who is not a member of the group is unable to run the XPP Administrative tool. Users must be assigned to a group to run the tool. However, if you do not create the xyadmin group, all XPP users can run the XPP Administrative tool.

*Note: If you remove any one of these groups after its creation, all client systems must reboot for the permission changes to take effect.*

The default “network” lookup mode for these special Windows group definitions is to query for definitions at the network level, that is, groups defined anywhere in the network of trusted domains. XPP first looks for a local group definition on the computer running XPP. Next XPP looks for a primary domain group definition (a group defined in the domain of the computer running XPP). Last XPP looks for a domain group definition on the network (of trusted domains). If there is more than one network group definition (and not a local or primary domain group definition), then determining which network definition will be used by XPP is nondeterministic.

XPP can be set to two other lookup modes to limit where XPP looks for these group definitions. XPP can be set to a “domain” lookup mode, which will limit group lookup to only local and primary domain groups. And XPP can be set to a “local” lookup mode, in which case only local groups will be used. The “domain” and “local” lookup
modes can be used for XPP installations on systems that are on large networks (perhaps with many domains), to be able to more independently define the XPP application security groups without affecting every XPP installation on such a network.

The lookup of these special groups can also be completely disabled, if they are not being used to limit XPP application permissions to certain XPP users. For example, you might want or need to disable the lookup of groups if there are network problems which are preventing XPP users from having full application permissions (see XPP Security Lock-Down Mode on page A-4), or it may be that the lookup of group definitions on the full network is too slow and causing performance problems for those using XPP.

The xpp_groups program, run from the command line only, is used to check or modify settings as to whether and how XPP looks for application security groups. In order to use this program to modify these settings, the user running the program must have Administrator permissions. For the options to this program, read the on-line help file by running xyhelp xpp_groups or see XML Professional Publisher Command Line Utilities.

**Note:** If xpp_groups has been used to change from the default settings, and later the XPP Server system name is changed, then the xpp_groups settings will revert to the default settings. The xpp_groups program will have to be run again to set the desired settings. This is because the XPP Server name (obtained from the XYV_ADVP_NODE environment variable for XPP Clients) is used in the encryption of the saved xpp_groups settings.

### Application Permissions Groups and Multiple Domains

If you establish the xyadmin, xystyle, xyjstyle, or xyperuse groups in one domain, and an XPP installation anywhere in the network of trusted domains is using the default “network” mode for groups, you affect user access in any such installation of XPP in ALL trusted domains. Thus, if these groups are defined anywhere, they can affect users everywhere in that network of trusted domains. It is up to the Windows system administrator (or network administrator) to ensure that all valid XPP users from ALL trusted domains are included in the appropriate group(s), and that appropriate trust relationships have been established between domains, or that all installations of XPP on the network are set to use an appropriate group lookup mode.

### XPP Security Lock-Down Mode

To implement XPP Security, by default XPP queries the entire network of trusted domains (or the Active Directory forest of trusted domains) for the existence of the special XPP application groups. Certain network problems can prevent XPP from successfully discovering the security groups. If this happens, XPP will go into “XPP security lock-down mode” and deny non-Administrator users access to XyAdmin and deny edit access to style specs and jobs. This is because these groups are application groups for security; if XPP cannot determine whether the groups exist (and who belongs to them), then for security reasons XPP must assume that the groups exist and that the current user does not belong to them.
A typical scenario where this “XPP security lock-down mode” may occur is when the special security groups are not being used, but a domain controller in the AD forest has malfunctioned or has been removed from the forest without having updated the network. Because XPP cannot successfully query the entire defined network for the existence of the security groups, it goes into lock-down mode and denies access to some operations. When the XyAdmin/PathFinder applications are started, the user may be presented with a window with messages like the following (from XyAdmin):

- CheckGroup(xyadmin) - unexpected LookupAccountName() error
  (error 1788: the trust relationship between the primary domain and the trusted domain failed.)
- Problem specifically with trusted domain DOM
- XPP will act like you do not belong to the 'xyadmin' group
- You are also not running as an administrator (possibly due to UAC)
- You do not have permission to use XyAdmin

One solution is to diagnose and fix the network problems. The example diagnostic messages shown above indicate that DOM is the domain that is not responding.

Other solutions, which can be temporary or permanent, to allow XPP users to continue working until the network problems are resolved might include the following:

1. Run XyAdmin and/or PathFinder using “Run as administrator”. This may be necessary, including for an Administrator user account, if Windows UAC (User Account Control) is enabled as that may be preventing the user account from running with Administrator access.

   The administrator permissions enabled in XyAdmin and PathFinder will be inherited by any process initiated from those applications.

2. Temporarily define the special XPP security groups on the local domain (or the local machine) and add all XPP users (or the xppusers group, if defined, or “Everyone”) to the groups. If XPP security groups were not being used, it should only be necessary to temporarily define the xyadmin security group.

   Once the network problems are resolved, remove any XPP security groups that have been temporarily defined.

3. Use the **xpp_groups** command to change the lookup mode of the special XPP security groups to the “domain” mode or “local” mode, or if the application security groups are not being used then disable the lookup of these groups.

   For more information about using **xpp_groups**, see Chapter 2: “Supported Command Line Utilities” in the *XML Professional Publisher Command Line Utilities* publication.

The XyAdmin and PathFinder applications have some built-in diagnostics to try to determine what network error is occurring. For the 1788 network error (shown in the previous example), the messages will indicate which domain is not responding to the request for the existence (and definitions) of the XPP security groups. The messages will also indicate that XPP has to deny access to certain operations.

These diagnostics only occur when the XyAdmin and PathFinder applications are started (other XPP applications like Sdedit and XyView do check for the XPP security groups, but they do not contain the extra diagnostics). If such network errors occur after they are already running, and users have write access denied to style specs or
jobs, then restart the XyAdmin or PathFinder application to learn whether there are any diagnostic messages given that will help in determining what network problem has occurred.

On the pop-up error message window, by default only the last diagnostic message is visible. Click on the Details >> button (and expand the size of the window) to display the full set of diagnostic messages.

**Source of Access**

The xyadmin, xystyle, xyjstyle, and xyperuse groups control access via XPP applications (xyadmin, xzplorer, sdedit, and xyview) only. To control back door access (like delete from the command line or Windows Explorer), manually set file system and share permissions on the local file systems where XPP resides.

The following table provides recommended share permissions for the XPP directories for the XPP users (xppusers), xyadmin, xystyle, and xyjstyle groups. The xyperuse group can be assigned the same permissions as the xppusers group or made a member of the xppusers group.

**Table A-1: Recommended Share Permissions**

<table>
<thead>
<tr>
<th>Folder</th>
<th>xppusers</th>
<th>xyadmin</th>
<th>xystyle</th>
<th>xyjstyle</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>path\xz\bin</code></td>
<td>Read</td>
<td>Full Control</td>
<td>Read*</td>
<td>Read*</td>
</tr>
<tr>
<td><code>path\xz\sys\config</code></td>
<td>Read</td>
<td>Full Control</td>
<td>Read*</td>
<td>Read*</td>
</tr>
<tr>
<td><code>path\sd_liz</code></td>
<td>Read</td>
<td>Full Control</td>
<td>Full Control</td>
<td>Read*</td>
</tr>
<tr>
<td><code>path\xz\help</code></td>
<td>Read</td>
<td>S.A. r, w, x, d</td>
<td>Read*</td>
<td>Read*</td>
</tr>
<tr>
<td>%XYV_JOB%</td>
<td>S.A. r, w, x, d</td>
<td>Full Control</td>
<td>S.A. r, w, x, d</td>
<td>S.A. r, w, x, d or Full Control</td>
</tr>
</tbody>
</table>

where:

- * indicates you do not have to assign these group permissions if group members are also members of the xppusers group.
- path represents the user-defined location(s) for the xz and sd_liz directories.
- %XYV_JOB% represents the job handles set up under Start > Programs > XyEnterprise > XML Professional Publisher > XPP > Administrative Tools, and then in XyAdmin, File > Document Paths.
- S.A. r, w, x, d is SPECIAL ACCESS: read, write, execute, delete.

**Share Permissions**

Setting the permissions above must be done on the local file systems where the specific XPP trees physically reside. It is entirely possible to have xz, sd_liz and %XYV_JOB%
all living on different machines, so be sure you set the permissions on the machine where the tree lives.

As for sharing these directories so XPP clients can access them, there is not much to worry about once the local file system permissions have been assigned. When local permissions and share permissions are consulted by Windows, the most restrictive wins. So, you can share the XPP trees with full control for everyone provided that the correct local file system permissions have been applied.
# Troubleshooting

<table>
<thead>
<tr>
<th>Problem Area</th>
<th>Description/Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Having two identical logins—one defined for your PC and one defined for a domain—can cause some XPP functionality to fail, for example, the save/restore function considers this configuration as being two different users.</td>
</tr>
<tr>
<td>Installation</td>
<td>You may encounter error messages if you write to a temporary folder using remote access. Remote access software sometimes points to a folder that is not writable or no longer exists. Check the XYV_TMPS path variable. You may need to provide the full path when writing to temp files.</td>
</tr>
</tbody>
</table>
| Third-party software | If XPP or third-party products do not function properly, check the PATH variable. On occasion, multiple installations truncate the PATH variable.  
The XPP installation backs up PATH before beginning an upgrade or install. The installation program writes the backup to %XYV_EXECS%\PrevPath.txt.  
See also, Third-party Upgrades on page B-3 |
<table>
<thead>
<tr>
<th>Problem Area</th>
<th>Description/Solution</th>
</tr>
</thead>
</table>
| Unable to open a division by double-clicking (or right-clicking and choosing Open from the pop-up menu) after installing XPP. | If enabled, firewall settings require an exception for an outbound rule to allow Ports 5053 and 5054 access:  
Outbound rule  
TCP  
On the Domain Local Port (all ports)  
Remote Port 5053, 5054  
Check the firewall settings (see Changing the Port Number on page C-1). |
| Get the following error message: Bad server hostname in license file or port@host | When attempting to run XPP, you may encounter this error message as the XPP application fails. This may be due to either an incorrect hostname in the license file, or if an sdlxysoft_LICENSE environment variable exists, an incorrectly entered hostname in this environment variable. |
| Users are denied access to XyAdmin or are denied edit access to style specs or jobs. | Network problems may be causing XPP to deny access to some operations (see XPP Security Lock-Down Mode on page A-4). |
| When you run a task in a background queue (in XPP PathFinder), the list of queued-up tasks is empty.  
When you run Background Process Control (Conshell), it displays an error "Cannot run, 'bgquer' not running." The error message might also include the "Cannot connect to bgquer on port #2994 on 'system" error message.  
First, you should verify that the bgquer service is running on the XPP server. | If a firewall is enabled, you must add a rule to the firewall on the XPP Server and XPP Clients to open Port 2994 for the bgquer service.  
See the “Setting Up Auto-Processing” and “Background-Processing Services” in Chapter 1 of the XML Professional Publishing: Managing XPP publication. |
| If you open XPP PathFinder, select a DIV, and then try to print, the print interface flashes and hangs (in XPP PathFinder). | This means that Port 2994, which is used by the bgquer, is already in use. You can change the port number in Windows by modifying the %WINDIR%\system32\drivers\etc\services file.  
If the line is missing, you must add it using the same format as other lines in the file:  
bgquer xxx/tcp # XPP Background processing port  
This is the XPP Background processing port number, where xxx is a port number that is different than Port number 2994). |
Third-party Upgrades

If a third-party application failed to upgrade, do the following:

First Attempt
1. Rerun XPP install
2. Select Third-party Products only
3. Select the product(s) that failed to upgrade
4. Execute the upgrades

If this attempt is successful, your upgrade is complete.

Second Attempt
1. Uninstall the offending 3rd-party application(s)
2. Rerun XPP install
3. Select Third-party Products only
4. Select the product(s) that failed to upgrade
5. Execute the upgrades
Third-party Upgrades
Appendix C
Licensing Across a Firewall

This appendix explains how to change the port number in the license file on the XPP server.

Changing the Port Number

If you want to serve licenses across a firewall, both license servers—the Reprise License Manager (RLM) and the sdlxysoft server (ISV)—need known port numbers for your firewall to pass requests on these ports.

The RLM server is always set at two known port numbers (5053 and 5054), the first of which you specify in the license file on the SERVER or HOST line. The RLM server also starts up the sdlxysoft server with a dynamic port number, which is not known before startup time.

To assign a fixed port number to the sdlxysoft server

1. Change to the RLM license directory.
   
   [drive]:\Program Files\XyEnterprise\SDL_License
   or [drive]:\Program Files (x86)\XyEnterprise\SDL_License
   
2. Edit the license file xxxxx.lic as follows:
   
   Change the ISV line as follows:
   
   ISV sdlxysoft port=####
   
   Important! Do not change any other lines or the license may become invalidated.

3. Change the firewall settings to turn on 5053/5054/XXXX (where XXXX is the port # you chose).

4. Open the new port.

   Instruct your firewall to allow connections to both the port number on the SERVER or HOST line (for the RLM server) and to the port number on any ISV line (for the sdlxysoft server).
5. Restart the license manager.

Use the service control panel to stop and restart the license server. For example, on Windows Server 2008 click **Start > Administrative Tools > Services.** The **Service name** is **SDL_License.**
SDL Group
201 Edgewater Drive
Wakefield, MA 01880-6216